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The Melexis PTC-01 software is a Windows application that provides a user interface to program Melexis’ 
family of PTC™ (Programmed Thru the Connector) programmable Ics.  The software is a 32 bit Windows ap-
plication program that uses a serial COM port to control a specified Melexis Programmer/Tester. 
 

System Architecture 
The PTC-01 software consists of the following main components: 
 
1) Program Shell. The Program Shell is the main executable portion of the program. It manages the main 
window and frame, File l/O, and preferences. 
 
2) Device (Personality) Modules. The device Modules are DLL's (Dynamic Link Libraries) which contain the 
forms and control software specific to a particular device type.  The user selects a device or personality mod-
ule at the shell level and it is dynamically linked to the shell code.  At program startup, all personality modules 
located in the program directory will be discovered automatically.  
 
3) User Interface.  The user interface is part of the device module.  It contains the functions and features used 
in developing applications with Melexis PTC sensor ICs. 
 
3) Programmer Interface. This is a DLL that manages the serial I/O and translates operation requests - 
typically between the Personality Module and the Programmer specific commands (firmware). 

Important Note: 
This document is written specifically for the MLX90215 Module.   It provides an overview of the PTC-01 and 
gives instructions for using the MLX90215 device module. 
 

Section 1 Overview 

Other Required Documents 
The following documents are required in addition to this one for use of the PTC-01 software and MLX90215 
device module.   
 
• PTC-01 datasheet 
• MLX90215 datasheet 
• PTC-01 Software Installation Notes 

Note to Software Developers: 
Melexis considers the PTC-01 software to be open source code.  That is, upon request, Melexis will supply 
any available source code.  Melexis does not directly support software development, but will provide direct 
application support.  Melexis fully supports the firmware functions and PTC-01 hardware.  Please contact 
Melexis for further information. 
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System Architecture 

Section 2 Software Installation 
Installation is done by running the setup or install file provided with the software.  For more detailed installation 
instructions please refer to the installation notes provided with the software. 

Requirements 
To install and use the PTC-01 software, your system must have the following: 
 
Windows 9x, Windows ME, or Windows NT  
An unused serial port. (Male DB9) 
5 Megabytes of free disk space. 

Software History 
For revision information please refer to the release notes located in the Readme.txt file provide with the software. 

Serial I/O

Personality Modules Program Shell

User Interface
Programmer Unit Program Interface
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Section 3 Launching the Software 
 

Launching the Software 
The software can be launched through the Windows start menu or through Windows Explorer by executing  
PTC-01.exe. 
 

From the Start Menu    
1) Go to the START menu. 
2) Go to PROGRAMS, then MELEXIS. 
3) Click PTC-01 

Section 4 The Program Shell 
When the PTC-01 software is launched successfully the following window will appear.  Check the revis ion 
information located in lower right hand corner.  The revision should correspond with  this document. 
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Starting a Device Module Session 
From this window you can either start a new session 
or previously saved session. 
 
To start a new session choose New from the File 
menu or click the blank paper document icon.  The 
software will now search for all available device 
modules.  A screen will then appear with the list of 
available modules.  Select the desired device and 
click OK. 

 
To open a previous session choose Open from the File menu or click the folder icon.  You may then browse 
and locate the saved session.  Once you select a file click open to begin the session. 
 
When a Device session is loaded the software will then load any saved preference and presets from the 
registry.  

Section 5 The MLX90215 Device Module 

Description 
The software was designed as a tool for rapid development of MLX90215 sensor  applications.  The software 
provides a simple user interface for programming the MLX90215 and taking measurements.  It has two main 
interface screens, manual and auto-calibration.  The manual mode gives the user control over all the pro-
grammable features of the sensor.  The auto-calibration mode will optimize the programmable settings for 
the application.  The software can be used for engineering development, analysis, and small volume produc-
tion. 
 

Main Features 
• Manual screen  
• Auto-calibration screen 
• Data log capabilities 
• Absolute and Relative Measurements 
• Save Session Presets and Settings 
 
 
It is strongly recommended that the MLX90215 datasheet be carefully reviewed before using this software.  
The software takes advantage of the advanced features of the MLX90215.  Without a basic understanding of 
the MLX90215 it will be difficult to utilize the features of the software.  
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5A Setting-Up a MLX90215 Device Session 
After launching the device module the program preference must be configured.  The preference window can 
be accessed by going to the file menu then preferences or clicking the “preferences” button.  The preference 
window  with its default settings is shown below.  The preferences are remembered when the device session 
is saved.   

Programmer Type  
Select the compatible programmer unit connected to the PC.  The software is compatible with SDAP02 or 
PTC-01 units with firmware version 2.0E or higher.  Firmware upgrades are available by contacting Melexis. 

Serial Port Communication Settings  

Select the external COM port the programmer is connected to. The selections shown are the ports made 
available to the software by the PC.  Select the Baud rate compatible with the programmer unit.  The PTC-01 
uses a rate of 19200. 

Manual Calibration 

These are optional settings for the manual calibration mode.   Auto Load executes a “load” action after a de-
vice parameter has been changed.  Auto Measure executes a “measure” action after a device parameter is 
changed. 

Auto Calibration 

These are optional settings for the auto calibration mode.  The options are used for displaying the error or 
deviation that occurs during the auto-calibration.    The units can also be set in auto-calibration setup. 



PTC-01 
Programmer for Melexis PTC Devices 

PTC-01 Programmer User’s Manual                                     Rev 1.2                                    15/NOV/2001                     Page 8 

5B The Menus and Toolbar 
The MLX90215 device module has five menus and seven commands on the tool bar.  The menus appear in 
both the manual and auto-calibrate modes. 

The Toolbar 
Going from left to right on the toolbar are the following commands: 
                 New:  Command to create a new device session 
                 Open:  Command to open a preciously saved device session 
                 Save:  Command to save the current device session 
                 Manual Form:  Command to access the manual calibration mode 
                 Auto Form: Command to access the auto-calibration mode 
                 About:  Gives revision information for the software 
                 Help:  Provides help information for the software 

The Menus 
The “File” menu contains all the file commands similar to any standard windows application.  Underneath the 
menu are commands for creating a new device session, opening a previously saved device session, saving 
the current device session or exiting the program.  The preferences window can also be accessed under the 
file menu. 
 
The View menu contains the available display options.   Two of the display options are Manual and Auto.  By 
selecting these options the user can toggle between the manual and auto-calibration modes.  The View menu 
also has options for toggling the toolbar or the status bar on or off.  The status bar displays helpful information 
on the bottom of the screen. 
 
The Action menu contains commands for executing special functions.  Some functions under the action menu 
may not be available in both the manual and auto-calibration modes.  The actions commands are also repre-
sented as button in either calibration mode.  The use of these functions are described in more detail later in 
this document. 
 
The Log menu contains all the command for setting up the data log file.  The use of this menu is explained in 
more detail in the data log section. 
 
The Help Menu is similar to that of any windows application.   The help files and revision information can be 
accessed under the help menu. 
 
Important Note: Revisions previous to and including 1.2.07 are not equipped with help files.  This option will 
be made available in future revisions.  Melexis apologizes for any confusion and encourages customers to 
call Melexis for an immediate response to any questions.  
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Device Parameters 

Measurement 
Results  

Device Presets 

Action Buttons 

Programmable 
Supply 

5C The Manual Calibration Mode 
The MlX90215 device module has two main user interfaces, manual and auto-calibration.  Shown below is the 
manual calibration interface.  It can be accessed by selecting “manual” under the view menu or by clicking the 
manual icon on the toolbar.  The manual calibration mode gives the user control over all the programmable 
features of the MLX90215.  The user can adjust any of the parameters, load them into the device, and  then 
make measurements.  The manual mode also has tools to permanently program the sensor (zap),  read back 
sensor parameters, and make relative measurements.  This mode is most effective for engineering develop-
ment and analysis.  By using the manual calibration mode the user can quickly develop a good understanding 
of MLX90215 and its available features.   
 
The Manual calibration interface has five basic sections.  The sections are highlighted and listed below.  Within 
the sections are adjustable parameters, displays, and special functions.  The adjustable parameters are indi-
cated by a white background.  The displays are shown as gray indented boxes.  The special functions are rep-
resented by raised buttons.     
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Device Parameters 
Listed in rows are the programmable features, or parameters, of the MLX90215.  The parameters combined 
represent the programmable bits of memory in the MLX90215.   The parameters are divided into two col-
umns, RAM and ROM.  The two columns represent two operating modes of the MLX90215.  The RAM mode 
is a test mode that uses volati le memory to store device parameters.  Because the device is using temporary 
memory the device parameters can be loaded as many times as needed.  This mode is ideal for adjusting 
the device parameters to calibrate the sensor.   To operate the device in RAM, or test, mode click on the RAM 
parameter  and execute the load function.   
 
The ROM mode is the normal operating mode of the MLX90215.  In this mode the device uses parameters 
set in nonvolatile memory.   Values set in ROM are physically burnt into the IC and cannot be reset.  The user 
can use the read back function to read the parameters set in ROM.  After the read back function is performed 
the results are displayed in the ROM column.   This mode is used for making measurements and analysis.  
To operate the device in ROM, or normal operating, mode click on the ROM parameter and execute the load 
function.  
 
For more information on the use of the device parameters refer to the MLX90215 datasheet.  Please read the 
sections in this document on action buttons for more information on the Load, Zap, and read back, functions.   
 
Important Note: 
The RAM mode and Read back functions are disabled when the Memlock bit is set in ROM.  If the Memlock 
bit is set the device can only be used in ROM mode.  Please refer to the MLX90215 datasheet for more infor-
mation on the Memlock bit.  

Programmable Supply 
The programmable supply feature is self explanatory. To set the supply click in the box and type in the de-
sired voltage.  Next execute the Load function to set the supply output.  For specifications on the programma-
ble supply refer to the programmer’s datasheet.   

Device Presets 
The presets are a useful tool for remembering device parameters.  To set a preset, first set the desired de-
vice parameters.  Next, click the set preset button.  Select one of the available preset buttons, type in the de-
sired name and click OK.  To load the preset device parameters simply click on the desired preset button.  
The figures below give an example or two presets being set.  One preset is for a device with low sensitivity or 
gain and the second is for a device with high sensitivity.  When the device session is saved the preset infor-
mation is saved.   If the device session is not saved the preset information will be lost upon exiting the pro-
gram.     
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Manual Calibration Action Buttons 
The action buttons are specialized functions for the MLX90215.  There are four actions available in the man-
ual calibration mode.  These include Load, Read back, Measure, and Zap.  The functions can be executed by 
clicking the button or by the action menu. 
 
Load 
The Load function sends the digital waveform, or vector, to program the MLX90215.  The Load action will also 
set the programmable supply.  The load command should be executed every time before making a meas-
urements and after a parameter has been changed.  Refer to the Preferences window for information on 
automatic load setting. 
 
Measure 
The Measure function reads the ADC measurement of different channels in the programmer.  The measure 
command will read the Vdd, Vout, and Idd measurements from the programmer.  The results of a measure 
are displayed in results sections. 
 
Read Back     
This functions loads a special set of vectors to read the contents of the MLX90215 ROM.  The contents of the 
ROM is read by loading the read back waveforms and measuring the supply current, Idd.  Any additional cur-
rent from additional components measured on the supply line may give false results.    The read back func-
tions also returns all zeros when the Memlock bit is set in ROM.  Results from the read back function appear 
under the ROM column.  
 
Zap 
The Zap function outputs the waveforms, or vectors, needed to permanently program bits into the MLX90215.  
The term “zap” is used because it describes the physical process of setting a bit in the MLX90215 ROM.  
This action is permanent.  Once a bit has been set or zapped it can not be reset.   When the Zap action is 
executed the device parameters under the RAM column will be permanently programmed into the device.  
This function should be performed after the sensor has been calibrated and the user is satisfied with the 
results obtained in RAM. 
 
Attention:  In the event incorrect bits are zapped the device cannot be reworked and may need to be dis-
carded  
Warning:  Erroneous zapping can render a device useless. 
 

Results 
The results section contains 8 display blocks separated into two columns.  The columns are labeled abso-
lute and ratiometric.   The absolute results are the actual measurements made by the programmer.  The ra-
tiometric results are measurements made by the programmer and compensated for an ideal supply voltage 
of five Volts.  Ratiometric measurements help eliminate error from minor deviations in the supply voltage.    
All of the Voltage measurements are displayed in units of Volts unless otherwise stated.  The %Vdd result 
displays the output voltage (Vout) as a percentage of the supply.  The Idd result displays the measurement of  
supply current in units of mA.   
 
There are two displays in the results section under the heading relative.  By using the Zero button the user 
can make relative measurements of the output voltage.  To do this execute the Measure function to measure 
the sensors output.  Press the zero button to set this value as the reference.  Adjust the sensor and measure 
again.  The results in relative section will display the output voltage relative to the previous reference.  The 
values are displayed in units of Volts and are shown as both absolute and ratiometric.  This feature is useful 
for measuring the voltage span of the sensor.        
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5D The Auto-Calibration Mode 
The manual interface is an excellent tool for engineering development.  However, for most applications, 
manually setting all the device parameters can be cumbersome and time consuming.  The Auto-Calibration 
interface provides the user with a semi-automated method for programming the MLX90215.  This interface 
makes use of specially developed algorithms to determine the best device parameters to meet the users’ 
specifications.      Given the proper information, the software will calculate the crucial device parameters re-
lated to offset and sensitivity.  The Auto-Calibration mode is a great tool for prototyping and small volume pro-
duction. 
 
The auto-calibration interface is shown below with three sections highlighted.  Like the manual mode the 
white boxes are user adjustable inputs, the raised buttons are specialized functions, and the indented gray 
boxes are output displays.  To access the auto-calibration interface the user can select “Auto” from the view 
menu or click the “Auto form” button on the toolbar. 

Device Parameters Action Buttons Calibration Results  
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The Auto-Calibration Setup 
To use auto-calibration the user must first configure the parameters specific to the application.  To do this 
enter the auto-calibration setup window.  The setup window can be accessed by selecting “setup” from the 
actions menu or by clicking the “setup” action button.   
 
The auto-calibration routine use two points to calculate the slope and one point for the offset.  The process 
consist of calculating the slope between two points and shifting the slope to hit a specified point.  The points 
used for calibration are in the setup window and must be configured by the user.  The setup widow is shown 
below.  The parameters entered are an example of a setup for calibrating a rotational-position sensor using 
the MLX90215.   

The auto-calibrate setup has four sections, input parameters, output parameters, transfer function, and offset 
calculation.   All of the parameters are required for the auto-calibration to work properly.  The setup parame-
ters are saved when the device session is saved.  
 
Input Parameters 
The Input parameters help define the measurement range for the application.   There are three required in-
put parameters, Units, Min, and Max.  Units represent the media the application is sensing.  The example 
above is for a rotational-position sensor measuring degrees of rotation.  The units are not used in any calcu-
lation but help define the transfer function and other terms and displays.  Min represents the minimum set-
point of the application.  For this example the min set-point is –45 degrees.  Similarly Max is the max set-
point of the application and is set to 45 degrees for this example.  During the calibration process the user will 
be asked to set the sensor to min and max set points.   It is recommended that the set-points chosen can be 
achieved and are repeatable.  Also note the two input set-points are used to calculate the sensitivity or gain.  
Proper selection of these points will help to reduce errors caused by non linearity.    
 
Output Parameters 
The output parameters help define the output range of the sensor.   The min and max output settings should 
correspond to the min and max input.  In this example the user wants a sensor output of 1.0 Volts and at -45 
degrees and 4.0 Volts at 45 degrees.     
 
Transfer Function 
In this section the software calculates the linear  transfer function using the input and output parameters.  
The span is defined as the maximum minus the minimum.  The sensitivity is calculated as the output span 
divided by the input span.   
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Offset Calculation 
Most application have a critical point within its operating range.  This point tends to have very strict tolerances 
relative to the entire output range.  The offset calculation feature allows the user set the critical calibration 
point for the application.  The actual offset is often different than the critical set-point.  However, the offset 
DAC is used to adjust the output to the critical set-point.  This forms the relationship between calculating the 
offset and the users’ critical calibration point. 
  
Using the intermediate-point option the user can select any value between the min and max input parame-
ters.  The user must specify the critical point as a percentage of the calculated input span.  Using the min 
and max options the user can also select the critical calibration point.  These options correspond to the input 
parameter set-points.  Using the intermediate option will create an additional step in the calibration process.  
The min and max options require no additional steps.  Careful selection of this parameter along with the in-
put parameters can help minimize errors caused by non linearity.  
 
As an example the user’s rotational-position sensor may have a critical tolerance at 0 degrees.  Using the 
intermediate option the user can select a value of 50% of the span.  This means the point of 2.5 Volts at 0 
degrees will be precisely calibrated.   
 
In the example setup window previously displayed the user selected the min input parameter as the critical 
calibration point.     
 
Memlock On Zap 
In the lower left corner of the setup window is the option “Memlock on Zap.”  After the calibration process the 
user has the option to permanently program, zap, the sensor.  If this option is checked the software will set 
the memlock bit during the zap function.  Note, setting the memlock bit will compromise the verify and read-
back functions.   With the memlock bit set these functions will return no results or all zeros. 

Device Parameters 
The device parameter are separated into two sections, settings and results.  The results section displays the 
device parameters that are calculated during the auto-calibration.   There are two adjustable parameters, un-
der settings, that are not calculated and must be set by the user.  The temperature compensation parameters, 
tempco, must be set before the auto-calibration.  The Clamp feature can be set before the auto-calibration or 
prior to zap.   Note, when setting the clamp before the auto-calibration make sure it will not interfere with the 
set-points.   Saturating or clipping of the output may degrade the calibration accuracy.  For example do not set 
the clamp for 4.5 Volts and use a set-point of  4.75 Volts. 
 
Shown below are the device parameter results after the auto-calibration.        
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Executing the Auto-Calibration Routine 
After the setup has been completed and the device parameters set the user can now run the auto-calibration.  
The auto-calibration can be started by selecting “calibrate” from the actions menu or by clicking the 
“calibrate” action button.  The software will then prompt the user with further instructions. 
 
Overview 
The auto-calibration routine first takes a series of measurements at both min and max set-points.  The pa-
rameters are specially selected to work with nearly every conceivable application.  Using these measure-
ments the calibration routine uses a look-up table to make an estimate for the gain and offset parameters.  
Next the software make several measurements and uses a linearization technique to fine-tune the gain or 
sensitivity.  Finally the software take several more measurements and uses some mathematical formulas to 
set the applications critical point.  The routine takes one final set of measurements to check the accuracy of 
the calibration.  Through the entire calibration the user will be prompted to adjust the sensor five times.  If the 
intermediate option is selected six adjustments are necessary.  
 
Results 
The results of automatically calibrating the rotational-position sensor are shown below.  In the first column of 
the results window  some of the setup parameters or target specifications are displayed.  The second col-
umn shows the measured results from the auto-calibration.  The third column displays the error between the 
target specifications and the measured results.   
 
Important Note: 
The auto-calibration routine calibrates the sensor for an ideal supply voltage of 5.0 Volts.  This is done by 
using ratiometric values during its calculations.  This means the measured output values are compensated 
for variations in the supply voltage.  The measurements displayed in the results window are absolute values 
and may have some error caused by variation in the supply voltage.  The user can use the manual mode to 
determine the absolute error of the calibration.   

The View in Manual Mode Function 
Located in lower right corner of the auto-calibration screen is a button labeled “View in Manual.”  When the 
user clicks on this button the software will switch from the auto-calibration interface to the manual interface 
screen.  During the switch all of the device parameters from the auto-calibration interface are copied to the 
RAM device parameters in the manual interface.  The users can automatically calibrate the sensor, click the 
“View in Manual” button, and make any additional adjustments or measurements.  Note, device parameters 
can not be copied from the manual interface to the auto-calibration interface. 
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Check Results 
This function allows the user to verify the measured results from the auto-calibration.  Check results can be 
executed by selecting “check results”  under the actions menu or by clicking the “Check Results” button.  
Once executed, the software will prompt the user to adjust the sensor to the previous set-point.  The sensor 
output will be measured and the results will be updated.   

Finishing the Calibration Process 
The user has now completed the auto-calibration routine and is satisfied with the results.  The sensor may 
now be permanently programmed or zapped.  To do this the user can either select “zap” from the actions 
menu or click the “Zap” button.  When executed the device parameters will be permanently set in the 
MLX90215 ROM.  The user can use the verify function to check if the device parameters were properly set in 
ROM.  To execute select “verify” from the actions menu or click the “Verify” button.  If an error was detected the 
software will prompt the user.  Note, If the Memlock on zap option is set the verify will produce false results.  
The verify function is the same as the read back  function used in the manual interface. 

Section 6 The Data Log Feature 
The data log feature allows important information to saved electronically.  The information is saved in a 
Comma Separated Value, CSV, format.  This standard format can be used by nearly any spreadsheet or data 
analysis software.  The logged parameters are configured by the user.  The logging feature can be disabled, 
used manually, or automated in the auto-calibration mode. 
 
The Log Menu 
There are six commands located under the Log menu.  The commands and their purpose are explained be-
low.  Log files are accessed differently than a document or spreadsheet file.  Therefore the file commands 
are slightly different.  It is important to read the information provided below.  
 
Open 
This is the command for opening a new log file.  It is not the same as the traditional file open command in 
that it is not used to open a previously saved log file.  This command is used to create a new log file.   
 
Append 
This is the command is used to append to an existing log file.  Any information recorded will added to the 
end of the existing log file. 
 
Pause 
This command is for temporarily stopping the log function.  When checked no information will be recorded in 
the log file. 
 
Close 
This command is used to close the current log file. 
 
Log 
The log function is used to manually log information.  This is a specialized function similar to those functions 
under the action menu. 
 
Preferences  
This command is used to access the log preferences window.  In this the window the user can customize 
and configure all the data log options. 
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Opening/Creating a Log File 
The first step in setting up the data log is to open a log file.  To create a new  log file choose open from log 
file menu.  Type in the file name and click save.   To append an existing log file select “append” from the log 
menu.  Choose the log file and click save. 
 
Configuring the Data Log Parameters 
After a log file has been opened the user must configure the log parameters.  The parameters are located 
under the Log preferences window.  To access the Log preferences window the user can select 
“preferences” from the log menu.    The log preferences menu is displayed below. 

The preferences window is divided into two tabs, Manual Mode and Auto Mode.  The tabs correspond to the 
manual and auto-calibration interfaces.  The log function for each interface is independent.  Therefore the log 
parameters must be configured separately.  By clicking on the tabs the user can switch between the two con-
figurations.  Displayed above is the Auto Mode tab for configuration of the auto-calibration data log. 
 
Listed in the log preferences window are two list, Available and Selected.  The items listed under available 
represent the parameters that may be recorded in the log file.  The selected items represent the parameters 
that will be recorded.  The user can use the buttons between the two columns to add and remove items.  The 
items in the selected will be recorded in the same order as shown in list.  Using the “Move Up” and “Move 
Down” button the user can change the order of the parameters.  
 
At the bottom of the Auto Mode tab is the option for the software to automatically log the selected parameters.  
The users has three options, Manual Only, After Calibration, and After Zap.  The Manual Only option will only 
log parameters when the user executes the log functions.  The After Calibration option will log parameters 
after the user has executed the calibration function.  Similarly, the After Zap option will log parameters after 
the user executes the zap function.    
 
The automatic logging options are not available in Manual Mode.  When in the manual calibration interface 
parameters will only be recorded when the user executes the log function. 
 
When finished with the log preferences click ok to close the window.  The log preferences will be saved 
when the devices session is saved.    
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Executing the Log Function 
When working in the manual interface or using the manual logging option for the auto-calibration interface, 
the user must execute the log function to record any parameters.  The user can execute the log function by 
selecting “Log” from the log menu or clicking the “Log” button on the interface screen.  Each time the log 
function is executed the selected parameters will be recorded in a single row in the log file.   
 
Important Note 
The parameter headings and units of measurement are not recorded in the log file.  Only the value of the pa-
rameter is saved.   

Section 7 Shortcut Keys 
In the interface screens and windows certain functions or commands have an underscored letter.  This letter 
represents a shortcut key which can be used to execute the function or command via the keyboard.  To use 
the shortcut keys hold down the “Alt” key and press the desired shortcut key.   
 
Example: In the manual interface screen the user can execute the Measure function with out using the 
mouse by holding down the “Alt” and pressing the “m” key.  Similarly the user can select the File menu by 
pressing “alt +f”. 
 
Some shortcut keys can be operated just by pressing the indicated letter.  As an example, the Measure func-
tion can be executed by just pressing the “m” key in addition to the method mentioned above.  Similarly the 
Load function can be executed by pressing the “l” key.    
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Section 8 Application Support 
 
Systematic Approach for Calibrating the Sensor 
The MLX90215 is a versatile product with many possible adjustments.  The versatility of the product can sim-
plify a design and improve accuracy.  As with any product with multiple adjustments a good procedure is 
needed to efficiently use the device.  Randomly making adjustments will add time and difficulty for the user 
calibrating a sensor.  However, by taking a systematic approach sensors can be calibrated quickly and with 
relative ease.  
 
The PTC software has an effective automated calibration tool.  This section describes the process used in 
the automated calibration tool.  Understanding the calibration process will help developers create new prod-
ucts, diagnose problems, and improve performance.  The following information provides a general approach 
to programming the MLX90215.  Upon request Melexis will provide any additional information or specific 
technical support.          
 

Programming Procedure 
1.  Read the MLX90215 datasheet.  Using the datasheet try to estimate some of the parameters.  Make sure 
the target specifications are within the limits of the devices. 
 
2.  Determine the TC parameter.  This should be the first fixed parameter and used throughout the program-
ming process.  TC parameter should be determined from either the magnet manufacturers technical specifi-
cations and recommendations or from experimental data. 
 
3.  Adjust the sensor’s sensitivity.  The term sensitivity also refers to gain, slope, and voltage span per unit.  
Usually the unit of measure is fixed and the sensitivity is adjusted to achieve the specified voltage span.  The 
rough gain and direction of slope parameters should be set first and fine adjustments made with the fine 
gain.  Try to avoid clipping or saturating the device output when adjusting the gain. 
 
4.  Adjust the offset.  The offset refers to the output voltage at zero field.  It can be adjusted to hit specific out-
put targets.  First set the 1/2 Vdd parameter and use the Offset DAC for fine adjustments. 
 
5.  Set the clamp parameter. 
 
6.  Verify the results 
 
7.  Set the Memlock and Zap the sensor.   
 
Note:  All adjustments are made in RAM.  Not all of the parameters are needed for every the application.    
 
Extra precaution:  The parameters should zapped before setting the memlock bit.  The ROM can then be veri-
fied or read back to ensure the proper bits are set.  As the final step the memlock bit can be individually 
zapped. 

The example on the following page shows a current sensor application using an MLX90215 being calibrated 
using the previous method.  The graphs depict the sensor output during the calibration process.  The target 
specifications are listed below. 
 
+/- 100 Am ps over a three Volt span 
Output must be 2.5 Volts at 0 Amps. 
Output must saturate at 0.5 and 4.5 volts. 
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Steps 1-2.  The TC parameter has been set and 
user has made an initial approximation.  The gain 
and offset are not correct but the output is not satu-
rated, leaving room for adjustment.    

Step 3.  The sensitivity has been adjusted to the 
correct output voltage span. 

Step 4.  The offset has been adjusted for an output 
of 2.5 Volts at 0 Amps. 

Steps 5-7.  The clamp parameter is set and the out-
put verified. The memlock bit is set and the device 
permanently programmed.  The sensor was cali-
brated successfully.  
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Section 9 Troubleshooting 
 
1) The programmer fails to responds.  This is most often the result of a communications problem between 
the PC and the programmer.  Check the cable connections and communications settings in the preferences 
window.  Look at the busy Indicator on the programmer.  The indicator will blink when communication has 
been established.  Try resetting the programmer using the reset switch. 
 
2) Readback function shows all bits have been zapped.  Make sure the device is inserted in the socket cor-
rectly.  If the device is inserted backwards it may be hot.  Use caution when removing it and discard the de-
vice.  Excessive current draw by the programmable supply  may give false results.  The readback functions 
works by measuring the device current (Idd).  If the programmable power supply is sourcing more than 8mA 
the readback and verify functions may give false results. 
 
3) After the device is zapped the output measured in ROM differs to the output measured in RAM.  Use 
the readback function to verify the correct code has been programmed.  Bits may have been zapped inadver-
tently.  Try to follow the recommended procedure in the applications setting.  Setting the TC parameter last 
may cause the sensitivity to shift.  Also use ratiometric measurements.  Variations in the supply voltage will 
appear on the sensors output.   
 
4) Programmable supply (Vdd) displays incorrectly.  The adjustable Vdd uses a single precision floating 
point number.  However, the display  is set for only three digits.  When editing the parameter use the arrow 
keys to place the cursor at most significant digit (left) for proper display. 
 
5) Auto-calibration routine will not converge.  This is usually caused by specifications outside the range of 
the device.  Try adjusting the input and output parameters.  Check the results to see what parameters are out 
of specifications.  Both the rough and fine gain should not be at their limits.  Verify the input parameters are 
correct.   
 
 
For technical support please contact Melexis 

Melexis Inc. USA 
41 Locke Road, Concord, NH 03301 
Phone: +1 603 223 2362                      Fax: +1 603 223 9614              
E-mail: sales_usa@melexis.com 


